MSDE BUSINESS ADMINISTRATIVE SERVICES

Program Objectives and Course Outlines

BMF Program Affiliate

3/4/2012

Prepared with special consideration by Dr. Nicole A. Buzzetto-More Associate Professor of Management, University of Maryland Eastern Shore and Director MSDE BMF Program Affiliate. Copyright 2011©. All rights reserved. This curriculum is designed for educational purposes. Users are forbidden to reproduce, republish, redistribute, or resell any materials from this document in either machine-readable form or any other form without permission of the MSDE.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Administrative Services Pathway</td>
<td>2</td>
</tr>
<tr>
<td>Business, Management, And Finance Program Affiliate</td>
<td>7</td>
</tr>
<tr>
<td>Course Information: Office Systems Management</td>
<td>9</td>
</tr>
<tr>
<td>Office Systems Management 1 Learning Objectives</td>
<td>10</td>
</tr>
<tr>
<td>Office Systems Management 1 Units</td>
<td>11</td>
</tr>
<tr>
<td>Course Information: Office Systems Management 2</td>
<td>15</td>
</tr>
<tr>
<td>Office Systems Management 2 Module 1 Learning Objectives</td>
<td>17</td>
</tr>
<tr>
<td>Office Systems Management 2 Module 1 Units</td>
<td>17</td>
</tr>
<tr>
<td>Office Systems Management 2 Module 2 Learning Objectives</td>
<td>18</td>
</tr>
<tr>
<td>Office Systems Management 2 Module 2 Units</td>
<td>20</td>
</tr>
<tr>
<td>Module 2 Alignment</td>
<td>24</td>
</tr>
<tr>
<td>Office Systems Management 2 Module 3 Learning Objectives</td>
<td>25</td>
</tr>
<tr>
<td>Office Systems Management 2 Module 3 Units</td>
<td>27</td>
</tr>
<tr>
<td>Module 3 Alignment</td>
<td>30</td>
</tr>
<tr>
<td>Business Administrative Services Appendix A</td>
<td>31</td>
</tr>
<tr>
<td>Business Administrative Services Appendix B</td>
<td>33</td>
</tr>
<tr>
<td>Business Administrative Services Appendix C</td>
<td>40</td>
</tr>
<tr>
<td>For More Information, Please Contact:</td>
<td>47</td>
</tr>
</tbody>
</table>
BUSINESS ADMINISTRATIVE SERVICES PATHWAY

The workforce has changed dramatically as a result of technological advancements made in the past two decades demanding that students enter the workplace prepared with advanced technical and 21st century skills. A study conducted by the Georgetown Center on Education and the Workforce (2008) projects that from 2008 to 2018, about two-thirds of the job openings in the U.S. will require at least some postsecondary education and training. More specifically, approximately half of the jobs that will require post-secondary education will go to people with an associate’s degree or occupational certificate. Often referred to as middle skill occupations, they include such career paths as construction, paralegal, health technology, nursing, office management, administrative services, bookkeeping, sales, event planning, repair and installation, massage therapy, and law enforcement (1).

Career and Technology Education (CTE) programs are developed in response to an identified opportunity to add value to students’ overall educational programs and align with the most appropriate, reliable, and valid technical standards available. CTE programs provide multiple options for students as they prepare for entry into careers and further education and are measured against student attainment of rigorous academic, employability and technical skills and student success in further education and employment.

Is there any proof CTE works? Students who complete a rigorous academic core coupled with an academically challenging CTE program of study have test scores that equal or exceed college preparatory students. Additionally, they are more likely to pursue postsecondary education, have a higher grade point average in college, are less likely to drop out of college in the first year, and have an easier time finding internships and employment opportunities than non-CTE students. In short, CTE programs have been cited for: preparing students to be career and college ready, helping students learn how to apply core academic skills to real world professional situations, building the employability soft skills of students such as communications and critical thinking, and providing students with job-specific technical skills (2). Further, CTE students have also been found to be significantly more likely to report that they developed problem-solving, project completion, research, math, college application, work-related, communication, time management and critical thinking skills during high school (3).

The Business, Management, and Finance (BMF) programs of study include: Business Administrative Services, Business Management, National Academy of Finance, Accounting, and Marketing. They represent programs of study all found at the University level. Reports consistently show that business remains the number 1 college major in the nation overall for both men and women (4). Additionally, in terms of persistence to graduation and number of degrees awarded, business holds the top spot representing nearly 25% of all degrees awarded annually (5).
Do BMF programs of study prepare students for academic studies in undergraduate business programs? Yes, students who take business courses while in high school are found to be better prepared for academic success in college business programs (6).

This Maryland BMF cluster focuses on four programs of study based on the Maryland State Department of Education framework for Business Management and Finance. Each program includes rigorous academics, broad cluster knowledge and skills, and technical skills related to one of the specific programs of study. The programs of study are: Business Administrative Services, Business Management, Marketing, and Finance and Accounting. Each course in the program of study has been identified and developed with regional postsecondary and business partners. Skills for Success and other workforce requirements are integrated throughout the coursework. Examples include workplace readiness, computer applications, written and oral communication skills, and math skills. Industry certifications are incorporated where appropriate. Opportunities are available for students to earn college credit through articulation agreements—such as dual enrollment and CLEP exams. Each program allows students to graduate with the skills and knowledge necessary to pursue post-secondary education and entry-level business positions.

The Maryland State Department of Education has committed itself to increasing the rigor of all CTE programs of study. This effort has included the development of State-wide Program Objectives and Course Outline aligned with the Microsoft Office Specialist (MOS) certification exams (Business Administrative Services) and the CLEP Exams (Accounting, Marketing, and Business Management). Further, the rigor of each program of study is being dramatically increased in order to better prepare students for career or college entry as well as to align with entry-level undergraduate courses for each respective discipline. With contemporary assurance of learning and assessment standards occurring in higher education, it is imperative that high school completer programs represent rigorous and not watered-down learning opportunities. The MSDE is supporting a federal mandate to incorporate certification and/or national standardized examinations into pathway courses in order to increase the career and college readiness of student, insure program validity and effectiveness as well as measure student achievement.

Students in all programs of study are required to take two core courses—Principles of Business Administration & Management and Principles of Accounting and Finance. All students learn effective decision-making techniques in financial management, business communication, problem-solving, teamwork and networking skills. Human resource topics such as diversity in the workplace, ethics, employer/employee rights, discrimination, accountability, time management, and setting priorities are also covered. Upon completion of the two core courses, students are required to complete remaining credits in their selected program of study such as Business Administrative Services, Business Management, Marketing, and Finance and Accounting.

The Maryland Business Administrative Services Pathway, provides students with knowledge of how to effectively utilize technology in the analysis, and communication of ideas; and the management, organization, and examination of information for strategic business decision making. Students are
expected to think analytically; improve written and oral communication skills; enhance listening and questioning skills; learn and practice the art of conversation; broaden their awareness of career options; practice decision making and problem solving; learn the importance of communication skills in professional business practice; and utilize data to engender decisions.


Students in all programs of study are required to take two core courses—Principles of Business Administration & Management and Principles of Accounting and Finance. All students learn effective decision-making techniques in financial management, business communication, problem-solving, teamwork and networking skills. Human resource topics such as diversity in the workplace, ethics, employer/employee rights, discrimination, accountability, time management, and setting priorities are also covered. Upon completion of the two core courses, students are required to complete remaining credits in their selected program of study such as Business Administrative Services, Business Management, Marketing, and NAF Academy and Accounting and Finance. To complete the Accounting Pathway the required completer courses are Advanced Accounting and Accounting and Finance Capstone.

All BMF programs of study recommend that students should have access to work study, mentorship, internship, and job shadow opportunities. Students also benefit from national professional organizations such as DECA or FBLA.

Upon completion of the two foundation courses, students enrolled in the Business Administrative Services Program of Study are required to complete Office Systems Management 1 and Office Systems Management 2. The second course in the sequence includes coursework in Microsoft Office Applications preparing students for Microsoft Office Specialist (MOS) Certification, a globally recognized credential desired by academia and business.

The following course outlines identifies the units to be taught in the Office Systems Management 1 and the Office Systems Management 2 courses. It is designed to culminate with the Microsoft Office Specialist certification examinations in Microsoft Word and Microsoft Excel.

The information presented in the following pages supports both Microsoft Office 2007 and Microsoft Office 2010.


The goal of the Maryland Business, Management, and Finance Program Affiliate is to provide curriculum development and professional development for business teachers in schools that are implementing the Maryland BMF Programs of Study. Formed in 2010, the Program Affiliate represents a partnership between the MSDE and UMES. In collaborative effort, the Maryland BMF Program Affiliate works with the MSDE Division of Career and College Readiness Career and Technology Education (CTE) branch to provide leadership; professional development opportunities for teachers; curriculum and technical assistance; program alignment to industry standards, professional certification requirements, and university/college credit requirements in order to ensure excellence across the BMF discipline. The Website for the BMF Program Affiliate can be found at www.BusinessEducationMSDE.com

Maryland State Department of Education (MSDE)
200 West Baltimore Street
Baltimore, MD 21201-2595
Phone: 410-767-0170
http://www.marylandpublicschools.org

MSDE Career and Technology Education Branch
Pat Mikos, Program Manager CTE Student Learning and Assessment Branch
Bridgette Sloan, Lead Specialist CTE Student Learning and Assessment Branch
200 West Baltimore Street
Baltimore, MD 21201-2595
http://www.marylandpublicschools.org/MSDE/divisions/careertech/career_technology

Maryland BMF Program Affiliate
Nicole Buzzetto-More, Director
2109 Kiah Hall
University Blvd.
Princess Anne, MD 21853
Nabuzzetto-more@umes.edu
http://www.BusinessEducationMSDE.com
The learning objectives and course outlines have been carefully scaffolded with new concepts being built upon existing knowledge as appropriate. Performance indicators have been written using Bloom’s Taxonomy of Educational Objectives. These performance indicators are appropriate to the intellectual development of the child in harmony with the curriculum content. As such, lesson plans and assessments should be developed with the educational objectives in mind. The model below is adapted from: http://connect.in.com/blooms-taxonomy/images-blooms-taxonomy-verbs-1-668324600279.html
Course Information: Office Systems Management (1 credit)

Course Description:
Office Systems Management provides the student with a study of basic business practices, information systems and computer applications. Students develop managerial and technical skills for business support operations through applied learning. Problem-solving skill development is incorporated throughout the course to meet the recommendations made through the Maryland Skills for Success. Competencies include: applying emerging technologies in order to complete appropriate office operations; using spreadsheet, desktop publishing and/or word processing software in order to create business documents and professional presentations; exhibiting appropriate interpersonal teamwork and leadership skills in order to succeed in the business world; demonstrating a knowledge of acceptable values and behaviors in order to become ethically responsible employees; and developing an appreciation of diversity in the workplace. Industry standard office equipment and the most current Microsoft Office software available will be used in this course. When students complete this course, they will know and be able to:

- Apply emerging technologies to appropriate office operations.
- Create business documents using spreadsheet, desktop publishing and word processing software based on Microsoft Office software.
- Develop employability skills, such as teamwork, accountability, positive work ethic, problem-solving and leadership skills.

A variety of assessment options are available for adoption. Listed below are recommended assessment options, which include: teacher-designed end-of-course assessment, school system- designed end-of-course assessment, e-portfolio project, partner-developed examination, the IC³ Fast Track assessment of digital literacy offered by Certiport, or Microsoft Certification testing.

- [ ] Teacher-designed end-of-course assessment
- [ ] School system-designed end-of-course assessment
- [ ] E-Portfolio Project
- [ ] Partner-developed exam
- [ ] IC³ credentialing exam
- [ ] Microsoft Certification Exam in MS PowerPoint and/or MS Outlook
- [ ] Nationally recognized examination: (other)
Office Systems Management 1

Office Systems Management provides the student with a study of basic business practices, information systems and computer applications. Students develop managerial and technical skills for business support operations through applied learning. Industry standard office equipment and the most current Microsoft Office software available are utilized. The curriculum is comprised of twelve units with pacing and lesson planning left to the discretion of individual counties, schools, or teachers. Counties and/or schools should take into consideration the prior educational experiences of students. As such, some content may require more or less attention. Additionally, schools may find the need to add additional content as needed.

As a BMF program of study, it is crucial that key business concepts are infused throughout this course. This should be done both during in-class discussions as well as through course exercises. For some units, desired applied business exercises have been suggested.

A variety of assessment options are available for adoption. Recommended assessment options, include: teacher-designed end-of-course assessment, school system-designed end-of-course assessment, an e-portfolio project, partner-developed examination, the IC3 Fast Track assessment of digital literacy offered by Certiport, the Microsoft Office Specialist Certification exam for PowerPoint and/or Outlook, or another project or examination.

For schools interested in adopting an e-portfolio project, student generated e-portfolios should be built around the learning objectives associated with the course and include relevant student work samples accompanied by meaningful reflections. For schools interested in adopting a nationally recognized assessment, the MOS exams for PowerPoint and Outlook are options. Additionally, the content for Office Systems Management 1 aligns with the IC³ Fast Track assessment for digital literacy. Please note, the IC³ is neither endorsed or required by the MSDE nor is the MOS for either MS PowerPoint or MS Outlook.

Office Systems Management 1 Learning Objectives

1. Student is able to explain major computing concepts.
2. Student is able to identify the major components of computing systems.
3. Student is able to conduct basic PC trouble shooting.
4. Student is able to explain networking fundamentals.
5. Student is able to identify how the internet and the World Wide Web each function.
6. Student is able to utilize the Web to locate information strategically and evaluate that information for usability and reliability.
7. Student is able to identify Internet threats and safety risks.
8. Student is able to perform basic file management in MS Windows.
9. Student is able to create and modify documents in MS Word.
10. Student is able to create and modify spreadsheets in MS Excel.
11. Student is able to create and modify a PowerPoint presentation with tables, charts, graphics, images, and multiple slide formats.
12. Student is able to utilize MS Outlook to send, receive, organize, and save Emails.
Office Systems Management 1 Units

The curriculum presented in the following pages supports both Microsoft Office 2007 and Microsoft Office 2010.

Unit 1
History of Computing
Role of Computing in the Shaping of Business and Industry
Types of Computing Devices
Elements of a Personal Computer
Understanding Types of Memory
Identifying Input/Output Devices
Working with Storage Systems
Identifying Printers
Troubleshooting Techniques
Maintaining and Upgrading Computers
Buying and Using a Computer

Unit 2
Understanding Networking Fundamentals
Recognizing Intranets and Extranets
Types of Networks (Local Area Network, Wide Area Network, Enterprise Private Network, Personal Area Network, Virtual Private Network, Storage Area Network, Controller Area Network, Wireless Networks)
How Networks Work (bridges, hubs, switches, and routers)
How the Internet Functions
What is an IP Address
Types of Business Communications Over the Internet and World Wide Web, Business-to-Business (B2B), Business-to-Consumer (B2C), and Consumer-to-Consumer (C2C)
Difference Between the Internet and the World Wide Web
How the World Wide Web works

Unit 3
Using Microsoft Internet Explorer Searching for Information on the World Wide Web
Locating and Using Reliable Online Sources
Conducting Queries in Library or Other Research Databases
Types of Information Sources
Qualifying Sources
Using Information
Citing and Referencing Sources

Unit 4
The Risks of Computing To People and Businesses
Cybercrime (spam, fraud, phishing, hacking, copyright infringement, cyberbullying malware, viruses, spyware, trojan horses, offensive content, identity theft, cyberstalking, bank fraud, theft of classified information other, and cyberterrorism)
Internet Security (firewalls, filters, antivirus software, encryption, and VPN
Internet Safety

**Unit 5**
Looking at Software Applications
Running Application Programs
File Management
Using the Recycle Bin
Managing and Maintaining Disks
Installing and Uninstalling Programs
MS Office Shared Features in Word/Excel/PowerPoint

**Unit 6**
Tabs and Features of MS Word
Creating Documents in MS Word
Editing Text
Formatting Text and Paragraphs
Page Formatting
Working with Themes and Fonts
Working with Pictures and Graphics
Working with Tables
Proofing Your Document
Printing Documents
Preparing Documents for Publication
Sharing Documents for Review
*Suggested Business Exercises*
- Professional Cover Letter
- Simple Price Sheet
- Simple Invoice
- Flyer or Invitation
- Resume

**Unit 7**
What is a Spreadsheet
Why do we use MS Excel
Tabs and Features of MS Excel
Setting Up a Spreadsheet in MSExcel
Hiding/Unhiding Rows and Columns
Adding a new sheet
Entering Text
Customizing Text in Cells (orientation, merging and centering, wrapping)
*Suggested Business Exercises*
- Budgets
- Using a Spreadsheet to Track Sales

**Unit 8**
Manipulating Information in MS Excel
Working with Simple Formulas
Applying Conditional Formatting
Formatting a Worksheet
Working with Charts
Previewing and Printing Worksheets

Suggested Business Exercises
- Annual Sales Report with Formulas, Conditional Formatting, and Charts

Unit 9
Introduction to PowerPoint and Working with Presentations
Setting Up the Presentation
Adding Slides and Slide Types
Formatting Slides Using Themes
Working with Pictures and Clip Art
Working with Smart Art Graphics
Using Sound
Working with Tables and Charts
Using Linked Objects
Saving the Presentation

Suggested Business Exercises
- Professional Sales/Business Proposal or Other Presentation

Unit 10
Working with the Slide Master
Preparing Templates
Customizing Themes
Working with Objects and Graphics
Creating Webpages in PowerPoint
Printing the Presentation, Creating Notes and Handouts
Preparing Slideshows, Adding Animations and Transition Effects
Recording Narration
Running the Slide Show

Converting to MS Word
Using the PowerPoint Options Button to Customize PowerPoint
Reviewing and Protecting Presentations
Preparing Presentations (inspect, mark as final, run compatibility, restrict permission, etc)
Publishing Presentations

Suggested Business Exercises
- Research Report Presentation

Schools interested in offering the MS PowerPoint Certification Examination may elect to do so following completion of Unit 10. PowerPoint Coverage is not included in the second course. Please note, the MOS PowerPoint Certification is not required by the MSDE.
Unit 11
Using Microsoft Outlook
Receiving Emails
Marking Emails
Filtering, Viewing, Deleting, Prioritizing, and Moving Emails
Creating Folders
Creating New Contacts and Organizing Contacts
Designating Signatures
Using Outlook Options (rules, automatic replies, themes, etcetera)
Finding Someone
Creating a Meeting Request
Responding to a Meeting Request
Sending Invitations, Notices, and Reminders
Managing Tasks
Viewing Calendar Items
Adding Items to the Calendar
Using the Out of Office Assistant
Customizing Outlook
Suggested Business Exercises
  o  Professional Email
  o  Set Up a Meeting in Outlook and Send Invitation Notices and Reminders

Schools interested in offering the MS Outlook Certification Examination may elect to do so following completion of Unit 10. Outlook Coverage is not included in the second course. Please note, the MOS Outlook Certification is not required by the MSDE.

Unit 12
New and Emerging Technologies
Keeping Up With Technology
Course Information: Office Systems Management 2

Course Description:
Students will develop advanced skills using Microsoft's leading business desktop software and acquire the Microsoft Office Specialist (MOS) credential. Students will be expected to think analytically, manipulate information, and use the computer as a productivity tool through integrated application programs. Expertise in technology will contribute to students' future career mobility, advancement potential, compensation and job satisfaction. When students complete this course, they will know and be able to:

- Demonstrate proficiency in Word, Access, and Excel.
- Obtain the advanced competencies to take the Microsoft Office Specialist exam for industry certification in MS Word and MS Excel.
- Acquire the skills and confidence to enter employment or continue their education, or both, upon graduation.

End of Course Assessment

☑ Certification or credentialing exam: MOS Excel, MOS Word
☑ Nationally recognized examination: MOS Excel, MOS Word
Office Systems Management 2

Students will develop advanced skills using Microsoft's leading business productivity software and acquire the Microsoft Office Specialist (MOS) credential. Students will be expected to think analytically, manipulate information, and use the computer as a productivity tool through integrated application programs. Expertise in technology will contribute to students' future career mobility, advancement potential, compensation and job satisfaction. When students complete this course, they will know and be able to:

- Demonstrate proficiency in Word, Access, and Excel.
- Obtain the advanced competencies to take the Microsoft Office Specialist exam for industry certification in MS Word and MS Excel.
- Acquire the skills and confidence to enter employment or continue their education, or both, upon graduation

Units have been identified for MS Access; however, detailed content has been developed to support MS Word and MS Excel. The curriculum has been divided into 3 modules. Module 1 covers the MOS Certification Process, MS PowerPoint and MS Access and is comprised of 2 units. Module 2 focuses exclusively on MS Word, is aligned to the MOS Certification Examination for MS Word and is comprised of 11 units. Module 3 focuses exclusively on MS Excel, is aligned to the MOS Certification Examination for MS Excel, and is comprised of 11 units. While a total of 24 units have been identified, pacing and lesson planning is left to the discretion of individual counties, schools, or teachers. Counties and/or schools should also take into consideration the prior educational experiences of students. As such, some units may require more or less attention than others.

As a BMF program of study, it is crucial that key business concepts are infused throughout this course. This should be done through hands-on course exercises and projects.

Appendix A presents the skills covered on the MOS Certification Examinations for MS Word and MS Excel. Appendix B contains a curriculum guide that aligns the MS Word, the learning goals and performance indicators to the recommended New Perspectives series texts and accompanying e-assessment system. Appendix C contains a guide that aligns the MS Excel, the learning goals and performance indicators to the recommended New Perspectives Series texts and accompanying e-assessment system. While there are a number of books available on the market to support MOS preparation and schools are free to select from any of the books available; however, two books have been identified based on their ability to meet the following criteria: case based approach to learning; incorporation of simple to follow illustrated hands-on projects; focus on critical thinking; cross curricular approach that incorporates aspects of accounting, marketing, general business, and technical writing; and availability of a coordinating e-learning and assessment system that maps learner progress, grades student work, provides tutorials, and offers remediation. The two recommended texts include the New Perspectives Series published by Cengage complimented by the SAM system and Microsoft Office published by McGraw complimented by SimNet.

The curriculum presented in the following pages supports both Microsoft Office 2007 and Microsoft Office 2010. Special addendums have been made where appropriate to address necessary modifications for individuals teaching Microsoft Office 2010.
Office Systems Management 2 Module 1 Learning Objectives

1. Student is able to explain the MOS Certification process.
2. Student is able to create and prepare professional presentations in Microsoft PowerPoint.
3. Student is able to work with the Slide Master in Microsoft PowerPoint.
4. Student is able to identify the components of a database.
5. Student is able to create a simple database in Microsoft Access.
6. Student is able to perform a simple query in Microsoft Access.

Office Systems Management 2 Module 1 Units

Introduction
Understanding the MOS Certification Process
About the Certification Exams
What to expect in the MOS Certification Exams
MOS Certification Exam Test Taking Tips

Unit 1
What is a database?
How do businesses use databases?
Difference between spreadsheets and databases.
Introduction to MS Access
Understanding the Features of MS Access
Opening and Navigating a Database in MS Access
Creating a Database in MS Access
Entering Records in a Database in MS Access

Unit 2
Building a Database and Defining Relationships
Naming fields and Objects, Assigning Field Data Types, Setting Field Sizes
Moving a Field, Adding a Field, Changing Field Properties
Creating Tables in MS Access
Importing data
Deleting Fields from a Table Structure, Renaming Fields in Design View, Changing the Data Type for Fields in Design View
Modifying Records, Finding Data in a Table, Deleting Records
Using AutoFilter to Sort Data, Sorting Multiple Fields in Design View
Maintaining and Querying a Database
Creating Custom Queries
Creating Entry Forms
Running Simple Reports
Office Systems Management 2 Module 2 Learning Objectives

1. Student is able to demonstrate their knowledge by locating and using the Word options tool to customize Word and set defaults.
2. Student is able to apply their knowledge of Word and business writing into the preparation of mailings and the performance of mail merges.
3. Student is able to apply layout and formatting changes in Word.
4. Student is able to illustrate and summarize ideas by using and modifying pictures and clip art, text boxes, Word Art, Smart Art, quick styles, and shapes.
5. Student is able to use Word to analyze, classify, compare, and relate information through tables, lists, graphics, and other objects.
6. Student is able to edit and prepare documents by using the review tab.
7. Student is able to organize content and structure with outlines.
8. Student is able to examine, inspect and secure documents.

MS Word Learning Objectives with Performance Indicators

1) Student is able to demonstrate their knowledge by locating and using the Word options tool to customize Word and set defaults.
   • From the MS Office Button, locate and use Word Options in order to personalize MS Word, modify display and printing default options, set proofing and autocorrect options, modify editing and saving default options, customize Word toolbars, and personalize their copy of Word (e.g. set user name or initials).
2) Student is able to apply their knowledge of Word and business writing into the preparation of mailings and the performance of mail merges.
   • Using the Mailings tab student is able to use the Step by Step Mail Merge Wizard, select recipients, prepare a recipient list, create labels and envelopes, and insert merge fields.
3) Student is able to apply layout and formatting changes in Word
   • From the home tab customize fonts, adjust character spacing, highlight text, add font effects, add and modify bullets and numbers, prepare custom bullets, change alignment, modify text orientation, show/hide formatting marks, modify line and paragraph spacing, and insert borders.
   • From the home tab clipboard group cut and paste, paste with and/or without formatting, paste special
   • From the home tab find and replace text.
   • From the view tab increase or decrease the zoom, select number of pages to display, change the view layout selection, show/hide the ruler, thumbnails, gridlines, and/or document map; and/or modify print layout.
   • Create a new document using a template, modify an existing template, and/or apply a saved template to an existing document.
   • Use the page layout tab to change margins and orientation, change alignment, set page colors and borders, show line numbers, insert page and section breaks, change tabs and indentations, and position objects or text.
• Under page layout change, customize and save themes.
• Insert drop caps, headers/footers, dates, page numbers, blank page, hyperlink, bookmark, or signature line.
• Select new styles, modify style sets, create new styles, manage styles, and use the style inspector.

4) Student is able to illustrate and summarize ideas by using and modifying pictures, clip art, text boxes, Word Art, Smart Art, quick styles, and shapes.
   • Student is able to illustrate and summarize ideas by formatting illustrations (move picture before, group objects, compress pictures), inserting and modifying text boxes, using Word Art, change fill, and working with the picture and drawing tools on demand tabs.
   • Student is able to add and modify smart art graphic organizers (adding a shape, changing shape, changing type, fill)

5) Student is able to use Word to analyze, classify, compare, and relate information through tables, lists, graphics, and other objects.
   • Student is able to convert text to columns
   • Student is able to prepare tables that communicate/classify/compare/relate information meaningfully.
   • Student is able to prepare multi-level lists in order to organize information effectively.
   • Student is able to prepare and insert inserting Excel objects that analyze, summarize, and/or compute information.
   • Student is able to add references and captions, bookmarks, cross references, tables of authorities, citations, tables of contents, and indexes in order to better relate information.

6) Student is able to edit and prepare documents by using the review tab.
   • Student is able to organize documents by using the review tab to track changes, accept or reject changes, manage mark ups, edit/add/delete comments, and compare or combine documents.

7) Student is able to organize content and structure with outlines.
   • Student is able to prepare outlines that classify and organize content.
   • Student is able to move items within outlines, show/hide levels, and save a document as an outline.

8) Student is able to examine, inspect, and secure documents.
   • From the Microsoft Office Button the student is able to examine a document by inspecting, running a compatibility checker and viewing and editing document properties.
   • From the Microsoft Office Button the student is able to prepare a document by encrypting the documenting, marking as final, adding a digital signature, restricting permission, and managing credentials.
   • From the Microsoft Office Button the student is able to publish and share a document as well as create a document workspace.
Office Systems Management 2 Module 2 Units

Unit 1- MS Word Basics

- Opening MS Word
- Identify Ribbons, Tabs, Contextual Tabs, and Mini Toolbars
- Accessing Help
- Saving files
- Create a new blank MS Word documents
- Use the home tab to format text in Word including font size, bold/underline/italicize
- Use the home tab to format paragraphs, line spacing, indents, bullets
- Use the home tab to find and replace text individually and simultaneously.
- Use the home tab to show/hide formatting marks
- Use the view tab to increase or decrease the zoom, select the number of pages to display, and change the view layout selection,
- Create a new document using a template, modify an existing template, and/or apply a saved template to an existing document.
- Use the view tab to show/hide the ruler, thumbnails, gridlines, and/or document map.
- Use the view tab to modify print preview and modify print layout.
- Use the home tab to customize fonts, adjust character spacing, highlight text, add font effects,
- Use the home tab to modifying bullets and numbers, preparing custom bullets, change alignment, text orientation, modify line and paragraph spacing, and insert borders.
- Use the clipboard on the home tab to cut and paste, use format painter, paste special, and paste with and/or without formatting.
- Use the styles group on the home tab to select new styles, modify style sets, create new styles, manage styles, and use the style inspector.

If Teaching Microsoft Office 2010 Incorporate

- 2010 Enhanced Ribbon Interface
- 2010 Backstage View (new) (It helps users to manage documents)
- 2010 Sharing files with Windows Live SkyDrive
- 2010 Protected Mode
- 2010 Quick Access Toolbar
- 2010 Navigation Pane
- 2010 Paste Preview

Unit 2- Page Layout and Illustrations

- Use the page layout tab to change page color
- Use the page layout tab to add/change page borders
- Use the page layout tab to change margins and orientation, change paper size, change tabs and indentations,
- Use the page layout tab to show line numbers insert page and section breaks,
- Use the page layout tab to select, customize and save themes.
- Use page layout to wrap text and change alignment
• Use page layout to change text to columns
• Use the insert tab to insert pictures and clip art
• Use on demand tab picture tools to format pictures and clip art including adding borders, adding effects, compressing, etc
• Use insert tab to insert text boxes
• Use on demand tab to modify text boxes
• Use insert tab to insert Word Art
• Use on demand tab to modify Word Art
• Use insert tab to draw shapes
• Use on demand drawing tools tab to customize shapes including changing fill, changing shape, rotating, adding effects, etc.
• Use page layout tab to align, bring to front/back, rotate, and group pictures, illustrates, shape, etc
• Use section breaks to manage changes in page orientation, page numbering, etc

*If Teaching Microsoft Office 2010 Incorporate*

- 2010 Enhanced themes
- 2010 Background Removal Tool (Insert > Picture > Option)
- 2010 Artistic Effects (Insert > Illustrations > Picture then Artistic Effects)
- 2010 Screen Capturing and Clipping Tools
- 2010 New Text and Image Editing Options

**Unit 3- Customization of MS Word**

• From the MS Office Button, locate and use Word Options in order to personalize MS Word (e.g. set user name or initials
• Use Word Options modify display and printing default options,
• Use Word Options to set proofing and autocorrect options
• Use Word Options to modify editing and saving default options
• Use Word Options to customize Word toolbars
• Use print preview to set printing options

*If Teaching Microsoft Office 2010 Incorporate*

- 2010 Customizing the Quick Access Toolbar

**Unit 4- Formatting Documents**

• Use the view tab to view in different formats
• Use the view tab to view side by side, split the window, and arrange within the window
• Create and re-use custom Templates
• Student is able to prepare multi-level lists in order to organize information effectively.
• Prepare outlines that classify and organize content.
• In outline view move items within outlines, show/hide levels, and save a document as an outline.
• Edit a document in HTML view
• From the Microsoft Office button use Save As to save a document in different file formats and change the title of an HTML file.
Use insert tab to drop caps, headers/footers, dates, page numbers,
• Use insert tab to insert blank page or cover page
• Use insert tab to insert hyperlink, bookmark, or cross reference
• Use insert tab to insert signature line
• Insert page breaks
• Insert quick parts
• Understanding Smart Art Graphics as visual organizers
• Use insert tab to add smart art graphics
• Use on demand tab to modifying smart art (adding a shape, changing shape, changing type, fill, move up/down)
  If Teaching Microsoft Office 2010 Incorporate
    o 2010 New Smart Art Graphics

Unit 4- Illustrations in Documents
  • Use the insert tab to insert pictures and clip art
  • Use on demand tab picture tools to format pictures and clip art including adding borders, adding effects, compressing, etc
  • Use insert tab to insert text boxes
  • Use on demand tab to modify text boxes
  • Use insert tab to insert Word Art
  • Use on demand tab to modify Word Art
  • Use insert tab to draw shapes
  • Use on demand drawing tools tab to customize shapes including changing fill, changing shape, rotating, adding effects, etc.
  • Use page layout tab to align, bring to front/back, rotate, and group pictures, illustrates, shape, etc
  If Teaching Microsoft Office 2010 Incorporate
    o 2010 Background Removal Tool (Insert > Picture > Option)
    o 2010 Artistic Effects (Insert > Illustrations > Picture then Artistic Effects)
    o 2010 Screen Capturing and Clipping Tools
    o 2010 New Text and Image Editing Options

Unit 6- Mailings
  • From the mailings tab use the Step by Step Mail Merge Wizard
  • Prepare a recipient list,
  • Create labels and envelopes,
  • Prepare and insert merge fields
  If Teaching Microsoft Office 2010 Incorporate
    o 2010 Letter Styling Options

Unit 7- Editing and Reviewing Documents
  • Use the review tab to track changes, accept or reject changes, manage mark ups
  • From the review tab use spell check, thesaurus, research, and the word count features
From the review tab edit/add/delete comments
- From the review tab compare and/or combine documents.
- From the review tab protect a document, restrict access, and manage credentials

If Teaching Microsoft Office 2010 Incorporate
- 2010 Enhanced Spell Checker
- 2010 Recover Mode
- 2010 Co-Authoring
- 2010 Author Permissions

Unit 8- Adding Tables and Objects
- Insert a table
- Customize a table
- Convert text to table
- Add simple functions to a table
- Insert Excel objects
- Insert PowerPoint objects

If Teaching Microsoft Office 2010 Incorporate
- 2010 Enhanced Equation Editor

Unit 9- Referencing
- Use the reference tab to add references and caption
- Use reference tab to insert endnotes, bookmarks, cross references,
- Use reference tab to add tables of figures, tables of authorities, tables of contents
- Make entries and add an index

Unit 10- Preparing, Protecting, and Publishing Documents
- From the Microsoft Office Button examine a document by inspecting, running a compatibility checker and viewing and editing document properties.
- From the Microsoft Office Button prepare a document by encrypting the documenting, marking as final, adding a digital signature, restricting permission, and managing credentials.
- From the Microsoft Office Button publish and share a document as well as create a document workspace.

If Teaching Microsoft Office 2010 Incorporate
- 2010 Protected Mode
- 2010 Trusted Documents
- 2010 Accessibility Checker

Unit 11- MOS Preparation
- Microsoft Certification Exam Review
# MS Word Alignment

<table>
<thead>
<tr>
<th>MS Word Learning Objective</th>
<th>Applicable Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  Student is able to demonstrate their knowledge by locating and using the Word options</td>
<td>Unit 3</td>
</tr>
<tr>
<td>tool to customize Word and set defaults.</td>
<td></td>
</tr>
<tr>
<td>2  Student is able to apply their knowledge of Word and business writing into the</td>
<td>Unit 6</td>
</tr>
<tr>
<td>preparation of mailings and the performance of mail merges.</td>
<td></td>
</tr>
<tr>
<td>3  Student is able to apply layout and formatting changes in Word.</td>
<td>Units 1-2</td>
</tr>
<tr>
<td></td>
<td>Unit 4</td>
</tr>
<tr>
<td></td>
<td>Unit 8</td>
</tr>
<tr>
<td>4  Student is able to illustrate and summarize ideas by using and modifying pictures and</td>
<td>Unit 2</td>
</tr>
<tr>
<td>clip art, text boxes, Word Art, Smart Art, quick styles, and shapes.</td>
<td>Units 4-5</td>
</tr>
<tr>
<td>5  Student is able to use Word to analyze, classify, compare, and relate information</td>
<td>Units 4-5</td>
</tr>
<tr>
<td>through tables, lists, graphics, and other objects.</td>
<td>Unit 8</td>
</tr>
<tr>
<td>6  Student is able to edit and prepare documents by using the review tab.</td>
<td>Unit 7</td>
</tr>
<tr>
<td>7  Student is able to organize content and structure with outlines.</td>
<td>Unit 4</td>
</tr>
<tr>
<td>8  Student is able to examine, inspect, and secure documents.</td>
<td>Unit 10</td>
</tr>
</tbody>
</table>
Office Systems Management 2 Module 3 Learning Objectives

1. Demonstrate basic formatting skills in the formatting of tabs, cells, columns, and worksheets.
2. Represent data in tables and charts
3. Demonstrate the ability to create and use graphics in Excel.
4. Review formulas and data
5. Protect, share, and manage workbooks.
6. Analyze data and synthesize concepts through the use of basic calculations and formulas such as subtotals, data ranges, averages, modes, count, minimum, and maximum.
7. Analyze and present data through filters and sorts and conditional formatting.
8. Make predictions by creating scenarios.
9. Name, use and edit ranges
10. Appraise and assess data through the use of intermediate formulations that look up and reference data, modify text, calculate dates/time, or use simple conditional logic (IF, THEN, AND, OR, SUMIF, AVERAGEIFS, ETC)

MS Excel Learning Objectives and Performance Indicators

1) Demonstrate basic formatting skills in the formatting of tabs, cells, columns, and worksheets.
   • Use the Home Tab to arrange sheets and workbooks by hide/unhiding rows and columns, adding a new sheet, renaming a sheet, wrapping text, change orientation, centering and merging text across cells, altering text orientation, modifying tab color, customizing font and number formats, and modifying row/column width.
   • Locate the features that will freeze panes, split worksheets, show/hide gridlines, arrange worksheets in the window, switch layouts, set print area, find and replace, paste only formulas or comments, zoom, and alter views.
2) Represent data in tables and charts
   • Convert a spread sheet to a Table.
   • Arrange and assemble concepts through the preparation of pivot tables and pivot charts.
3) Demonstrate the ability to create and use graphics and other visual elements in Excel.
   • Use clip art, smart art, pictures, shapes, backgrounds, borders and shading, fill, and colors to organize and illustrate concepts.
   • Select and customize themes.
   • Prepare smart art graphic organizers that interpret and/or represent ideas meaningfully.
4) Review formulas and data
   • Review workbooks and validate formulas by removing duplicates, performing error checking, refreshing, and tracing precedents/dependents.
   • Display formulas, track changes, and edit comments.
   • Create rules and examine data integrity.
5) Students will be able to protect, share, and manage workbooks.
   • Manage, and share workbooks by protecting workbooks, designating ranges that can be edited by users, managing credentials.
6) Analyze data and synthesize concepts through the use of basic calculations.
• Analyze data and conduct basic computations by adding subtotals, and inserting formulas that calculate averages, modes, count, minimum, and maximum by using the Formula Tab.
• Prepare formulas that reference cells across sheets.

7) Analyze and present data through filters, sorts and conditional formatting.
   • Present information by selecting a column and sort contents.
   • Locate and turn on and off filters.
   • Sort using multiple criteria.
   • Prepare a custom auto-filter and use other advanced filtering.
   • Differentiate data using conditional formatting
   • Evaluate information by setting an above average condition.

8) Make predictions by creating scenarios.
   • Use what-if analysis to synthesis concepts and make predictions through scenarios and goal seeking.

9) Name, use and edit ranges
   • Name and set ranges, paste names and use names in formulas.

10) Appraise and assess data through the use of the formula tab for formulations.
    • Insert a date or time formula.
    • Use transpose to modify an array.
    • Examine information by looking up and referencing an array of cells with HLOOKUP AND VLOOKUP.
    • Differentiate, and examine information using simple conditional logic (IF, COUNTIF, THEN, AND, OR, SUMIF, SUMIFS, AVERAGEIF, AVERAGEIFS, ETC)
Office Systems Management 2 Module 3 Units

Unit 1- MS Excel Basics
- Opening MS Excel
- Ribbons and Tabs
- Rows and columns
- Create new blank Excel file
- Enter content into a cell
- Workbooks and sheets
- Use the Home Tab to arrange sheets by hide/unhiding rows and columns, add rows and columns, modify row height, modify column width
- Use home tab to add a new sheet, rename a sheet, change tab color,
- Use home tab to wrap text, change orientation, center and merge cells, center text across cells,
- Customize font and number formats
- Use a template, modify an existing template, and/or apply a saved template
- Use the view tab to zoom, and alter views.
- Use the view tab to freeze panes, split worksheets, show/hide gridlines, arrange worksheets in the window, and switch layouts
- Use the view tab to set print area and save workspace
- Use the view tab to find and replace, paste only formulas or comments

If Teaching Microsoft Office 2010 Incorporate
  o 2010 Enhanced Ribbon Interface
  o 2010 Backstage View
  o 2010 Protected Mode
  o 2010 Quick Access Toolbar
  o 2010 Sharing files with Windows Live SkyDrive
  o 2010 Paste Preview

Unit 2- Tables and Table Tools
- Convert a spread sheet to a Table
- Sort columns in a table.
- Locate and turn on and off filters.
- Sort using multiple criteria.
- Filter in place
- Add a subtotal line
- Use table tools to change table styles, resize, and change table options
- Use table tools to get external data
Unit 3- Clip Art and Smart Art
- Insert clip art, smart art, pictures, shapes, backgrounds
- Use on demand tab to edit clip art/pictures, etc including changing fill, orientation, borders and shading, etc
- Insert smart art graphic organizers
- Use on demand tab to customize smart art
- Insert header/footer, signature line, hyperlink, etc

*If Teaching Microsoft Office 2010 Incorporate*
- 2010 Background Removal Tool (Insert > Picture > Option)
- 2010 Artistic Effects (Insert > Illustrations > Picture then Artistic Effects)
- 2010 Screen Capturing and Clipping Tools
- 2010 New Text and Image Editing Options
- 2010 New Smart Art options

Unit 4- Subtotals and Simple Formulas
- Adding subtotals
- Use formula tab to insert formulas that calculate averages, modes, count, minimum, and maximum
- From the home tab use conditional formatting
- From the home tab Manage rules
- From the data tab apply advanced filters
- Evaluate information by setting an above average condition.

Unit 5- Pivot Tables and Charts
- Use insert tab to insert pivot tables and pivot charts.
- Use on demand tabs to format pivot tables and pivot charts (axis title, row/height/details areas, add basic calculations, add/remove legend, show/hide details, etc)

*If Teaching Microsoft Office 2010 Incorporate*
- 2010 Slicers
- 2010 Enhanced Pivot Table options
- 2010 Sparklines

Unit 6- Using the Data and Review Tabs
- Display formulas
- Use review tab to track changes, and edit comments.
- From the data tab refresh
- From the data tab manage connections
- From the data tab remove duplicates, trace precedents/dependents, group/ungroup
- From the review tab manage, and share workbooks by protecting workbooks, designating ranges that can be edited by users, managing credentials.
Create rules and examine data integrity.

If Teaching Microsoft Office 2010 Incorporate
- 2010 Recover Mode
- 2010 Co-Authoring
- 2010 Author Permissions

Unit 7- What if Analysis
- Use what-if analysis to synthesize concepts and make predictions through scenarios and goal seeking.

Unit 8- Naming Ranges, Using Ranges in Formulas
- Use the formula tab to name and set ranges, paste names and use names in formulas.
- Using the formula bar prepare formulas that reference cells across sheets.
- Use the formula bar to perform error checking

Unit 9- Formulas That Reference An Array Or Use Conditional Logic
- Insert a date or time formula.
- Use transpose to modify an array.
- Examine information by looking up and referencing an array of cells with HLOOKUP AND VLOOKUP.
- Differentiate, and examine information using simple conditional logic (IF, COUNTIF, THEN, AND, OR, SUMIF, SUMIFS, AVERAGEIF, AVERAGEIFS, ETC)

If Teaching Microsoft Office 2010 Incorporate
- 2010 New Formulations

Unit 10- MS Office Button and Excel Options
- Use the Office button to edit properties, prepare spreadsheet, inspect sheet (run inspector), encrypt, restrict permission, mark as final, and run compatibility checker
- Use MS Excel Options to change user name, adjust properties, enable content, set defaults, customize Excel
- Publish Workbook

If Teaching Microsoft Office 2010 Incorporate
- 2010 Protected Mode
- 2010 Trusted Documents
- 2010 Accessibility Checker

Unit 11- MOS Preparation
- MS Excel Certification Exam review
## MS Excel Alignment

### MS Excel Learning Objectives

<table>
<thead>
<tr>
<th></th>
<th>Objective</th>
<th>Applicable Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Demonstrate basic formatting skills in the formatting of tabs, cells, columns, and worksheets.</td>
<td>Unit 1</td>
</tr>
<tr>
<td>2</td>
<td>Represent data in tables and charts</td>
<td>Unit 2, Unit 5</td>
</tr>
<tr>
<td>3</td>
<td>Demonstrate the ability to create and use graphics in Excel.</td>
<td>Unit 3</td>
</tr>
<tr>
<td>4</td>
<td>Review formulas and data</td>
<td>Unit 6</td>
</tr>
<tr>
<td>5</td>
<td>Protect, share, and manage workbooks.</td>
<td>Unit 10</td>
</tr>
<tr>
<td>6</td>
<td>Analyze data and synthesize concepts through the use of basic calculations and formulas such as subtotals, data ranges, averages, modes, count, minimum, and maximum.</td>
<td>Unit 4</td>
</tr>
<tr>
<td>7</td>
<td>Analyze and present data through filters and sorts and conditional formatting.</td>
<td>Unit 4</td>
</tr>
<tr>
<td>8</td>
<td>Make predictions by creating scenarios.</td>
<td>Unit 7</td>
</tr>
<tr>
<td>9</td>
<td>Name, use and edit ranges</td>
<td>Unit 8</td>
</tr>
<tr>
<td>10</td>
<td>Appraise and assess data through the use of intermediate formulations that look up and reference data, modify text, calculate dates/time, or use simple conditional logic (IF, THEN, AND, OR, SUMIF, AVERAGEIFS, ETC)</td>
<td>Unit 9</td>
</tr>
</tbody>
</table>
MS Word Skills Being Measured

- **Laying out documents.**
  - Make documents and content easier to find.
- **Formatting Content Format text and paragraphs.**
  - Manipulate text.
  - Control pagination.
- **Working with Visual Content Inserting illustrations.**
  - Format illustrations.
  - Format text graphically.
  - Insert and modify text boxes.
  - Organizing Content Structure content by using Quick Parts.
- **Use tables and lists to organize content.**
  - Modify tables.
  - Insert and format references and captions.
  - Merge documents and data sources.
- **Reviewing Documents**
  - Compare and merge document versions.
  - Manage tracked changes.
  - Insert, modify, and delete comments.
- **Sharing and Securing Content**
  - Prepare documents for sharing.
  - Control document access.
  - Attach digital signatures.

- Source Microsoft Corporation
MS Excel Skills Being Measured

Creating and Manipulating
- Insert data by using AutoFill.
- Ensure data integrity.
- Modify cell contents and formats.
- Change worksheet views.
- Data Validation rules
- Trace Precedents

Manage worksheets.
- Formatting Data and Content Format worksheets.
- Insert and modify rows and columns.
- Format cells and cell content.
- Format data as a table.

Creating and Modifying Formulas Reference data in formulas.
- Summarize data by using subtotals.
- Using formulas to create scenarios and using the scenario manager.
- Look up data by using a formula. (HLOOKUP, VLOOKUP)
- Use conditional logic in a formula.
- Using nested and logical formulas (IF, THEN, AND, OR, SUMIF, AVERAGEIFS, ETC)
- Format or modify text by using formulas.
- Display and print formulas.

Presenting Data Visually Create and format charts.
- Modify charts.
- Apply conditional formatting.
- Insert and modify illustrations.
- Sort and filter data.
- Pivot tables and pivot charts

Collaborating on and Securing Data/ Managing changes to workbooks.
- Protect and share workbooks.
- Prepare workbooks for distribution.
- Set print options for printing data, worksheets, and workbooks.

*Source Microsoft Corporation
## MS WORD ALIGNED TO CENGAGE NEW PERSPECTIVES SERIES

### GOAL 1: WORD OPTIONS
The student will apply their MS Word skills into the customization of Word Options.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
<th>SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS</th>
</tr>
</thead>
</table>
| 1.1 Student is able to demonstrate their knowledge by locating and using the Word options tool to customize Word and set defaults. | 1.1.1 From the MS Office Button, locate and use Word Options in order to personalize MS Word, modify display and printing default options, set proofing and autocorrect options, modify editing and saving default options, customize Word toolbars, and personalize their copy of Word (e.g. set user name or initials). | Tutorial 7, Collaborating with Others and Creating Web Pages: Pages WD 322-323; Exercises in Review Assignments (WD 367-368) and Case Problem 2 (WD 369-370)  
Tutorial 8, Customizing Word and Automating Your Work: Pages WD 402-405 and WD 419-426; Exercises in Review Assignments (WD 443-445), Case Problem 1 (WD 445-447), and Case Problem 2 (WD 447-449) (Chapter 8/tutorial 8 is not available in the 2nd Course book)  
SAM Assessment and Training Tasks: 27 AutoCorrect, 206 Customize Word, 978 Toolbars, 981 Toolbars – Customize, 1387 Customize the Quick Access toolbar, 1390 |

### GOAL 2: FORMATTING
The student will apply their MS Word skills into the layout and formatting in Word.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
<th>SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS</th>
</tr>
</thead>
</table>
| 2.1 Student is able to apply layout and formatting changes in Word. | 2.11 From the home tab customize fonts, adjust character spacing, highlight text, add font effects, add and modify bullets and numbers, prepare custom bullets, change alignment, modify text orientation, show/hide formatting marks, modify line and paragraph spacing, and insert borders. | Tutorial 1, Creating a Document: Pages WD 8-9 and WD 27-33; Exercises in Review Assignments (WD 38-39) and Case Problems 1-3 (WD 39-42)  
Tutorial 2, Editing and Formatting a Document: Pages WD 69-71, WD 74-77, and WD 80-82; Exercises in Review Assignments (WD 87-90) and Case Problems 1-4 (WD 90-95)  
Tutorial 4, Desktop Publishing and Mail Merge: Pages WD 174-176; Exercises in Review Assignments (WD 189-190) and Case Problem 2 (WD 192)  
SAM Assessment and Training Tasks: 349 Fonts, 962 Text – Format, 1055 Change font size, 1497 Apply a character style, 50 Bold Text, 1056 Italicize text, 1059 Underline a word, 1137 Change the color of text, 1299 Highlight text, 69 Case – Change, 1396 Change character spacing, 1127 Create a bulleted list, 65 Bullets - Change Type, 605 Numbered List, 631 Outline Numbered, 1403 Create a multilevel list, 55 Border Lines, 505 Justify Text, 653 Paragraph Spacing, 1058 Center a paragraph, 511 Line Spacing, 1133 Display formatting marks, 1399 Add a custom paragraph border  
SAM Projects: New Perspectives Word Tutorial 1 Case Problem 1; New Perspectives Word Tutorial 1 Case Problem 1 (Scenario 2); New Perspectives Word Tutorial 2 Case Problem 1; New Perspectives Word Tutorial 2 Case Problem 1 (Scenario 2) |
<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 2.12 | From the home tab clipboard group cut and paste, paste with and/or without formatting, paste special | Tutorial 2, Editing and Formatting a Document: Pages WD 57-61; Exercises in Review Assignments (WD 87-90) and Case Problems 1 and 2 (WD 90-92)
SAM Assessment and Training Tasks: 153 Copy Text, 218 Cut Text, 664 Paste Text, 1050 Cut and paste text, 1134 Use the Paste Options button, 1051 Copy and paste text
SAM Projects: New Perspectives Word Tutorial 2 Case Problem 1; New Perspectives Word Tutorial 2 Case Problem 1 (Scenario 2) |
| 2.13 | From the home tab find and replace text. | Tutorial 2, Editing and Formatting a Document: Pages WD 61-64; Exercises in Review Assignments (WD 87-90) and Case Problems 1-3 (WD 90-93)
SAM Assessment and Training Tasks: 339 Find Text, 750 Replace Text
SAM Projects: New Perspectives Word Tutorial 2 Case Problem 1; New Perspectives Word Tutorial 2 Case Problem 1 (Scenario 2) |
| 2.14 | Identify elements in the Word Window and from the view tab increase or decrease the zoom, select number of pages to display, change the view layout selection, show/hide the ruler, thumbnails, gridlines, and/or document map; and/or modify print layout. | Tutorial 1, Creating a Document: Pages WD 6-10; Exercises in Review Assignments (WD 38-39)
Tutorial 2, Editing and Formatting a Document: Pages WD 84-85; Exercises in Review Assignments (WD 87-90)
Video: Exploring the Word Window (Tutorial 1)
SAM Assessment and Training Tasks: 633 Outline View, 282 Draft View, 1047 Zoom, 770 Ruler – Display |
| 2.15 | Create a new blank document, create a new document using a template, modify an existing template, and/or apply a saved template to an existing document. | Tutorial 1, Creating a Document: Pages WD 6-10; Exercises in Review Assignments (WD 38-39)
Tutorial 5, Working with Templates and Outlines: Pages WD 202-208; Exercises in Review Assignments (WD 253-254) and Case Problems 1-3 (WD 254-258)
SAM Assessment and Training Tasks: 172 Create New Document – Template, 957 Template – Create New, 1393 Create a template |
| 2.16 | Use the page layout tab to change margins and orientation, change alignment, set page colors and borders, show line numbers, insert page and section breaks, change tabs and indentations, and position objects or text. | Tutorial 2, Editing and Formatting a Document: Pages WD 64-68 and WD 71-72; Exercises in Review Assignments (WD 87-90) and Case Problems 2-3 (WD 91-93)
Tutorial 3, Creating a Multiple-Page Report: Pages WD 102-103, WD 115-118, and WD 122-124; Exercises in Review Assignments (WD 139-140) and Case Problems 1-2 (WD 140-142)
Tutorial 7, Collaborating with Others and Creating Web Pages: Pages WD 356-357; Exercises in Review Assignments (WD 367-368)
SAM Assessment and Training Tasks: 475 Indent Paragraph, 505 Justify Text, 1052 Indent |
| 2.17 | Under page(261,310),(304,343)(251,372),(281,405)(241,436),(275,471)(231,504),(263,539)(221,571),(251,604)(211,630),(243,664) layout change, customize and save themes. | Tutorial 2, Editing and Formatting a Document: Pages WD 64-68 and WD 71-72; Exercises in Review Assignments (WD 87-90) and Case Problems 2-3 (WD 91-93)  
Tutorial 5, Working with Templates and Outlines: Pages WD 209-215; Exercises in Review Assignments (WD 253-254) and Case Problems 1-2 (WD 254-257)  
SAM Assessment and Training Tasks: 18 Apply a Theme, 1389 Customize a theme |
| 2.18 | Insert drop caps, headers/footers, dates, page numbers, blank page, hyperlink, bookmark, or signature line. | Tutorial 3, Creating a Multiple-Page Report: Pages WD 128-134; Exercises in Review Assignments (WD 139-140) and Case Problems 1-2 (WD 140-142)  
Tutorial 4, Desktop Publishing and Mail Merge: Pages WD 170-171; Exercises in Review Assignments (WD 189-190) and Case Problem 2 (WD 192)  
Tutorial 5, Working with Templates and Outlines: Pages WD 251-252; Exercises in Review Assignments (WD 253-254)  
Tutorial 7, Collaborating with Others and Creating Web Pages: Pages WD 348-354; Exercises in Review Assignments (WD 367-368)  
SAM Assessment and Training Tasks: 1380 Format a letter as a drop cap, 1128 Create a document header, 357 Footer - Page Number, 645 Page Numbers, 643 Page Number Formatting, 1145 Create a different footer in each section, 231 Date – Insert, 465 Hyperlink – Specify, 52 Bookmark, 1435 Insert a signature line for a digital signature  
SAM Projects: New Perspectives Word Tutorial 3 Case Problem 1; New Perspectives Word Tutorial 3 Case Problem 1 (Scenario 2) |
| 2.19 | Select new styles, modify style sets, create new styles, manage styles, and use the style inspector. | Tutorial 5, Working with Templates and Outlines: Pages WD 216-232; Exercises in Review Assignments (WD 253-254) and Case Problems 1-3 (WD 254-258)  
SAM Assessment and Training Tasks: 889 Style – Apply, 891 Style – Create, 894 Style - Create Character, 1060 Create a Quick Style Set, 1144 Reveal formatting, 1491 Use the Style Inspector |
### GOAL 3: MAILINGS
The student will apply their MS Word skills into the preparation of mailings.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
<th>SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS</th>
</tr>
</thead>
</table>
| 3.1 Student is able to apply their knowledge of Word and business writing into the preparation of mailings and the performance of mail merges. | 3.1.1 Use the Step by Step Mail Merge Wizard, select recipients, prepare a recipient list, create labels and envelopes, and insert merge fields. | Tutorial 6, Using Mail Merge: Pages WD 262-296; Exercises in Review Assignments (WD 304-306) and Case Problems 1-3 (WD 306-309)  
SAM Assessment and Training Tasks: 306 Envelopes, 545 Merge – Create Form, 547 Merge – Edit Data, 549 Merge – Insert Field, 551 Merge – Print, 689 Print Labels – Create, 1402 Create labels from lists, 1408 Edit a data source, 1416 Sort the records in a data source |

### GOAL 4: PRESENTING DATA AND INFORMATION
The student will apply their MS Word to present data visually in charts, tables, and other graphical elements.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
<th>SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS</th>
</tr>
</thead>
</table>
| 4.1 Student is able to illustrate and summarize ideas by using and modifying pictures, clip art, text boxes, Word Art, Smart Art, quick styles, and shapes. | 4.11 Illustrate and summarize ideas by formatting illustrations (move picture before, group objects, compress pictures), inserting and modifying text boxes, using Word Art, change fill, and working with the picture and drawing tools on demand tabs. | Tutorial 4, Desktop Publishing and Mail Merge: Pages WD 149-157 and WD 160-170; Exercises in Review Assignments (WD 189-190) and Case Problems 1-3 (WD 190-195)  
Tutorial 8, Customizing Word and Automating Your Work: Pages WD 381-385 and WD 408-410; Exercises in Review Assignments (WD 443-445) (Chapter 8/tutorial 8 is not available in the 2nd Course book)  
SAM Assessment and Training Tasks: 666 Picture – Insert, 102 Clip Art, 1438 Insert a shape, 967 Text Box – Insert, 1443 Fill text boxes with color, 1378 Create WordArt, 1146 Edit clip art, 1444 Compress pictures, 1142 Apply a QuickStyle to a picture, 286 Drawing – Flip, 289 Drawing - Send to Front, 412 Graphic - Text Wrapping, 1441 Change graphic position and text wrapping, 1439 Modify a shape  
SAM Projects: New Perspectives Word Tutorial 4 Case Problem 1; New Perspectives Word Tutorial 4 Case Problem 1 (Scenario 2) |
| 4.12 Add and modify smart art graphic organizers (adding a shape, changing shape, changing type, fill) | | Tutorial 3, Creating a Multiple-Page Report: Pages WD 124-128; Exercises in Review Assignments (WD 139-140) and Case Problem 2 (WD 141-142)  
SAM Assessment and Training Tasks: 1383 Insert SmartArt |
### GOAL 5: ANALYZING AND PRESENTING INFORMATION
The student will apply their MS Word skills to analyze and present data meaningfully.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
<th>SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS</th>
</tr>
</thead>
</table>
| 5.1 Student is able to use Word to analyze, classify, compare, and relate information through tables, lists, graphics, and other objects. | 5.1.1 Convert text to columns | Tutorial 6, Using Mail Merge: Pages WD 299-301; Exercises in Review Assignments (WD 304-306)  
SAM Assessment and Training Tasks: 1401 Convert text to a table |
| 5.12 Prepare tables that communicate/compare/classify/relate information meaningfully. | | Tutorial 3, Creating a Multiple-Page Report: Pages WD 103-115; Exercises in Review Assignments (WD 139-140) and Case Problems 1-4 (WD 140-145)  
SAM Assessment and Training Tasks: 926 Table – Insert, 1129 Create a table, 914 Table – AutoFormat, 916 Table – Borders, 935 Table – Shading, 1400 Add shading to a table, 1415 Create a custom format for a table, 929 Table - Insert Row, 922 Table - Delete Column, 931 Table - Merge Cells, 939 Table – Split, 918 Table - Cell Width, 1374 Change the alignment of text in a cell, 924 Table – Header, 937 Table – Sort, 1377 Use a formula in a table, 1410 Sum a column in a table |
| 5.13 Prepare multi-level lists in order to organize information effectively. | | Tutorial 2, Editing and Formatting a Document: Pages WD 74-84; Exercises in Review Assignments (WD 87-90) and Case Problems 1-3 (WD 90-93)  
Tutorial 6, Using Mail Merge: Pages WD 301-302; Exercises in Review Assignments (WD 304-306)  
SAM Assessment and Training Tasks: 1403 Create a multilevel list |
| 5.14 Prepare and insert inserting Excel objects that analyze, summarize, and/or compute information. | | Tutorial 7, Collaborating with Others and Creating Web Pages: Pages WD 333-345; Exercises in Review Assignments (WD 367-368), Case Problem 1 (WD 368-369), and Case Problem 3 (WD 370-372)  
SAM Assessment and Training Tasks: 1861 Embed an existing Excel chart, 1406 Link an existing Excel chart |
5.15 Add references and captions, bookmarks, cross references, tables of authorities, citations, tables of contents, and indexes in order to better relate information.

Tutorial 3, Creating a Multiple-Page Report: Pages WD 119-121; Exercises in Review Assignments (WD 139-140) and Case Problem 1 (WD 140-141)

Tutorial 5, Working with Templates and Outlines: Pages WD 242-248; Exercises in Review Assignments (WD 253-254) and Case Problem 3 (WD 257-258)

Tutorial 7, Collaborating with Others and Creating Web Pages: Pages WD 348-352; Exercises in Review Assignments (WD 367-368)

Tutorial 10, Managing Long Documents: Pages WD 547-552, WD 556-558, WD 579-586, and WD 586-596; Exercises in Review Assignments (WD 602-604) and Case Problems 1-4 (WD 604-611) (Chapter 10/tutorial 10 is only available in the Comprehensive Edition)

SAM Assessment and Training Tasks: 945 Table of Contents, 1405 Change the format of a table of contents, 359 Footnotes/Endnotes, 297 Edit Footnote, 1139 Insert a citation, 1140 Insert a bibliography, 1141 Create a source, 200 Cross Reference, 1442 Add a caption to a picture, 478 Index – Mark Entry, 1404 Build an index, 52 Bookmark

SAM Projects: New Perspectives Word Tutorial 3 Case Problem 1; New Perspectives Word Tutorial 3 Case Problem 1 (Scenario 2)

5.2 Student is able to organize content and structure with outlines.

5.21 Prepare outlines that classify and organize content.

Tutorial 5, Working with Templates and Outlines: Pages WD 237-240; Exercises in Review Assignments (WD 253-254), Case Problem 2 (WD 256-257), and Case Problem 4 (WD 258-259)

SAM Assessment and Training Tasks: 1372 Create an outline, 631 Outline Numbered

5.22 Move items within outlines, show/hide levels, and save a document as an outline.

Tutorial 5, Working with Templates and Outlines: Pages WD 240-242; Exercises in Review Assignments (WD 253-254), Case Problem 2 (WD 256-257), and Case Problem 4 (WD 258-259)

SAM Assessment and Training Tasks: 633 Outline View

GOAL 6: DOCUMENT REVIEW AND PREPARATION
The student will apply their MS Word to present data visually in charts, tables, and other graphical elements.

OBJECTIVE(S): INDICATOR(S): SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS

6.1 Student is able to edit and prepare documents by using the review tab.

6.11 Use the review tab to track changes, accept or reject changes, manage mark ups, edit/add/delete comments.

Tutorial 7, Collaborating with Others and Creating Web Pages: Pages WD 316-323 and WD 329-332; Exercises in Review Assignments (WD 367-368) and Case Problem 2 (WD 369-340)

SAM Assessment and Training Tasks: 128 Comment, 1375 Delete a comment, 991 Track Changes – Review, 1429 Use the Reviewing pane, 988 Track Changes, 1428 Accept and reject changes
| 6.12 | Compare and combine documents. | Tutorial 7, Collaborating with Others and Creating Web Pages; Pages WD 324-329; Exercises in Review Assignments (WD 367-368)  
SAM Assessment and Training Tasks: 280 Documents – Compare and Merge, 1426 Combine revisions from multiple authors |
| 6.2 | Student is able to examine, inspect, and secure documents. |  
6.21 Examine a document by inspecting, running a compatibility checker and viewing and editing document properties. | Tutorial 8, Customizing Word and Automating Your Work: Pages WD 410-413; Exercises in Review Assignments (WD 443-445) *(Chapter 8/tutorial 8 is not available in the 2nd Course book)*  
Tutorial 10, Managing Long Documents: Pages WD 562-564; Exercises in Case Problem 2 (WD 606-608) *(Chapter 10/tutorial 10 is only available in the Comprehensive Edition)*  
SAM Assessment and Training Tasks: 1384 Use the Document Inspector to remove unwanted data, 136 Compatibility Checker, 1135 Modify document properties |
| 6.22 | Prepare a document by encrypting the documenting, marking as final, adding a digital signature, restricting permission, and managing credentials. Unit 13 | Tutorial 10, Managing Long Documents: Pages WD 558-562 and WD 597-600; Exercises in Review Assignments (WD 602-604) and Case Problems 2-3 (WD 606-610) *(Chapter 10/tutorial 10 is only available in the Comprehensive Edition)*  
SAM Assessment and Training Tasks: 1437 Encrypt a document, 1386 Mark a document as final, 1062 Digital signature, 1432 Protect documents and give permissions |
| 6.23 | Publish and share a document as well as create a document workspace. Unit 13 | Tutorial 7, Collaborating with Others and Creating Web Pages: Pages WD 346-347 and WD 357-366; Exercises in Review Assignments (WD 367-368) and Case Problems 2-4 (WD 369-373)  
SAM Assessment and Training Tasks: 825 Send To |

There are several versions within the New Perspectives Series. This alignment presented works the New Perspectives First and Second Course Editions as well as the New Perspectives MS Word Introductory Edition, and the New Perspectives MS Word Comprehensive Edition. Please note that Chapter 8 is not available in the New Perspectives Second Course and Chapter 10 is only available in the Comprehensive Edition.

This alignment was conducted by members of the editorial staff of the Perspectives Series, representatives from the Cengage Learning Solutions group, SimNet representatives, and Cengage Enterprise Solutions sales representatives in partnership with Dr. Buzzetto-More.
GOAL 1: FORMATTING IN EXCEL
The student will apply their Excel skills in the formatting of worksheets, tabs, cells, columns, view panes, layout, and data based on a variety of conditions.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
<th>SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS</th>
</tr>
</thead>
</table>
| 1.1 Demonstrate basic formatting skills in the formatting of tabs, cells, columns, and worksheets. | 1.1.1 Use the Home Tab to arrange sheets and workbooks by hide/unhiding rows and columns, adding a new sheet, renaming a sheet, wrapping text, centering and merging text across cells, altering text orientation, customizing font and number formats, and modifying row/column width. | Tutorial 1, Getting Started with Excel: Pages EX 12-18 and EX 35-36; Exercises in Review Assignments (EX 48-49) and Case Problems 1-4 (EX 49-54) 

Tutorial 2, Formatting a Workbook: Pages EX 67-74 and EX 94-95; Exercises in Review Assignments (EX 102-104) and Case Problems 1-4 (EX 104-111) 

SAM Assessment and Training Tasks: 452 Hide Column, 1107 Unhide columns, 491 Insert Worksheet, 746 Rename Worksheet, 1272 Copy a worksheet, 1459 Format worksheet tabs, 1044 Wrap Text, 553 Merge Cells, 1108 Modify row height, 9 Align cell contents, 473 Indent Cell Contents, 763 Rotate Text, 75 Center Across Cells, 599 Number Format – Currency, 601 Number Format – Date, 1465 Format cells before entering data, 1740 Use custom format codes, 350 Fonts, 346 Font Size, 48 Bold Cell Contents, 498 Italicize Cell Contents, 998 Underline Cell Contents, 121 Color Text 

SAM Projects: New Perspectives Excel Tutorial 1 Case Problem 1; New Perspectives Excel Tutorial 1 Case Problem 1 (Scenario 2); New Perspectives Excel Tutorial 2 Case Problem 1; New Perspectives Excel Tutorial 2 Case Problem 1 (Scenario 2) |
| 1.1.2 Locate the features that will freeze panes, split worksheets, show/hide gridlines, arrange worksheets in the window, switch layouts, zoom, and alter views. | | Tutorial 1, Getting Started with Excel: Pages EX 3-5 and EX 41-43; Exercises in Review Assignments (EX 48-49) and Case Problems 1-4 (EX 49-54) 

Tutorial 5, Working with Excel Tables, PivotTables, and PivotCharts: Pages EX 220-221 

Tutorial 6, Managing Multiple Worksheets and Workbooks: Pages EX 297-299; Exercises in Review Assignments (EX 326-327) 

Video: Understanding Spreadsheets (Tutorial 1) |
### GOAL 2: CHARTING DATA
The student will apply their Excel to present data in charts, and tables.

#### OBJECTIVE(S):

| 2.1 Represent data in tables and charts | 2.11 Convert a spread sheet to a Table. |

**SUGGESTED ACTIVITIES:**

- **BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS**
  - CENGAGE NEW PERSPECTIVES BOOKS
  - Tutorial 5, Working with Excel Tables, PivotTables, and PivotCharts: Pages EX 221-224; Exercises in Review Assignments (EX 272) and Case Problems 1-4 (EX 273-278)
  - SAM Assessment and Training Tasks: 38 Autoformat – Table, 1273 Add a total row to a table, 1743 Insert rows and columns in tables, 1765 Rename a table
  - Tutorial 5, Working with Excel Tables, PivotTables, and PivotCharts: Pages EX 246-270; Exercises in Review Assignments (EX 272) and Case Problems 1-4 (EX 273-278)
  - SAM Assessment and Training Tasks: 1303 PivotChart Report, 1313 Create PivotChart, 1275 Format PivotTable, 670 Pivot Table Modify, 1302 Create PivotTable, 1768 Import data into PivotTable, 1308 scenario PivotTable report

#### INDICATOR(S):

| 2.12 Arrange and assemble concepts through the preparation of pivot tables and pivot charts. |

**SUGGESTED ACTIVITIES:**

- **BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS**
  - CENGAGE NEW PERSPECTIVES BOOKS
  - Tutorial 2, Formatting a Workbook: Pages EX 60-64 and EX 71-74; Exercises in Review Assignments (EX 102-104) and Case Problems 1-4 (EX 104-111)
  - Tutorial 4, Working with Charts and Graphics: Pages EX 199-202; Exercises in Review Assignments (EX 207-208) and Case Problem 2 (EX 209-210)
  - SAM Assessment and Training Tasks: 103 Clip Art, 1270 Insert a shape, 1261

### GOAL 3 PRESENTING INFORMATION
The student will apply their Excel to present information visually.

#### OBJECTIVE(S):

| 3.1 Demonstrate the ability to create and use graphics in Excel. | 3.11 Use clip art, smart art, pictures, shapes, backgrounds, borders and shading, fill, and colors to organize and illustrate concepts. |

**SUGGESTED ACTIVITIES:**

- **BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS**
  - CENGAGE NEW PERSPECTIVES BOOKS
  - Tutorial 2, Formatting a Workbook: Pages EX 60-64 and EX 71-74; Exercises in Review Assignments (EX 102-104) and Case Problems 1-4 (EX 104-111)
  - Tutorial 4, Working with Charts and Graphics: Pages EX 199-202; Exercises in Review Assignments (EX 207-208) and Case Problem 2 (EX 209-210)
  - SAM Assessment and Training Tasks: 103 Clip Art, 1270 Insert a shape, 1261
| 3.12 | Select and customize themes. | Tutorial 2, Formatting a Workbook: Pages EX 58-60 and EX 78-80; Exercises in Case Problems 1-2 (EX 104-108)
SAM Assessment and Training Tasks: 1076 Apply a theme to a worksheet, 1077 Customize a theme, 1766 Format and edit multiple worksheets at once
SAM Projects: New Perspectives Excel Tutorial 2 Case Problem 1; New Perspectives Excel Tutorial 2 Case Problem 1 (Scenario 2) |

| 3.13 | Prepare smart art graphic organizers that interpret and/or represent ideas meaningfully. | Appendix D, Working with Enhanced Formatting Tools: Pages EX D16-D21; Exercises in Review Assignments (EX D25-D26) and Case Problem 2 (EX D27-D28) (Only available in Comprehensive Edition)
SAM Assessment and Training Tasks: 1079 Insert a SmartArt graphic, 1735 Modify a SmartArt graphic |

**SAMPLE CURRICULUM GUIDE SHEET**

**GOAL 4: FORMULATIONS IN EXCEL**
The student will apply their Excel skills in creation and review of formulas for the evaluation of data.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
<th>SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS</th>
</tr>
</thead>
</table>
| 4.1 Review formulas and data | 4.11 Review workbooks and validate formulas by removing duplicates, performing error checking, refreshing, and tracing precedents/dependents. | Tutorial 7, Using Advanced Functions, Conditional Formatting, and Filtering: Pages EX 360-367; Exercises in Review Assignments (EX 384)
Tutorial 8, Developing an Excel Application: Pages EX 407-414; Exercises in Review Assignments (EX 443-444) and Case Problem 2 (EX 446-448)
SAM Assessment and Training Tasks: 1471 Remove duplicate rows, 1282 Add error alerts to cells, 1759 Check for data-entry errors using the IFERROR function, 1296 Trace errors, 986 Trace Precedents, 984 Trace Dependents |
## GOAL 5: MANAGING WORKBOOKS

The student will apply their Excel skills in the management of workbooks.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Students will be able to protect, share, and manage workbooks.</td>
<td>5.1.1 Manage, and share workbooks by protecting workbooks, designating ranges that can be edited by users, managing credentials.</td>
</tr>
</tbody>
</table>

**SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS**

- Tutorial 8, Developing an Excel Application: Pages EX 414-418; Exercises in Review Assignments (EX 443-444) and Case Problems 2-4 (EX 446-452)
- Appendix C, Creating a Shared Workbook: Pages EX C1-C24; Exercises in Review Assignments (EX C25-C26) and Case Problems 1-2 (EX C26-C27) *(Only available in Comprehensive Edition)*
- SAM Assessment and Training Tasks: 710 Protect Cells, 712 Protect Sheet, 1285 Protect workbooks, 836 Share Workbook, 1287 Save workbook with a password

## GOAL 6: BASIC CALCULATIONS

The student will apply their Excel skills by applying basic calculations.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
</tr>
</thead>
</table>

**SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS**

- Tutorial 8, Developing an Excel Application: Pages EX 414-418; Exercises in Review Assignments (EX 443-444) and Case Problems 2-4 (EX 446-452)
- Appendix C, Creating a Shared Workbook: Pages EX C1-C24; Exercises in Review Assignments (EX C25-C26) and Case Problems 1-2 (EX C26-C27) *(Only available in Comprehensive Edition)*
- SAM Assessment and Training Tasks: 710 Protect Cells, 712 Protect Sheet, 1285 Protect workbooks, 836 Share Workbook, 1287 Save workbook with a password
### GOAL 7: DATA ANALYSIS
The student will analyze and interpret data in order to inform decision making.

<table>
<thead>
<tr>
<th>OBJECTIVE(S):</th>
<th>INDICATOR(S):</th>
<th>SUGGESTED ACTIVITIES: BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS</th>
</tr>
</thead>
</table>
| 7.1 Analyze and present data through filters, sorts and conditional formatting. | 7.11 Present information by selecting a column and sort contents. | Tutorial 5, Working with Excel Tables, PivotTables, and PivotCharts: Pages EX 227-232; Exercises in Review (EX 272) and Case Problems 1-4 (EX 273-278)  
**SAM Assessment and Training Tasks:** 860 Sort |
| 7.12 Locate and turn on and off filters. | | Tutorial 5, Working with Excel Tables, PivotTables, and PivotCharts: Pages EX 233-238; Exercises in Review (EX 272) and Case 1-4 (EX 273-278)  
**SAM Assessment and Training Tasks:** 34 AutoFilter – Select, 32 AutoFilter |
| 7.13 Sort using multiple criteria. | | Tutorial 5, Working with Excel Tables, PivotTables, and PivotCharts: Pages EX 228-230; Exercises in Review Assignments (EX 272) and Case Problems 1-4 (EX 273-278)  
**SAM Assessment and Training Tasks:** 862 Sort – Multilevel |
| 7.14 Prepare a custom auto-filter and use other advanced filtering to categorize information. | | Tutorial 5, Working with Excel Tables, PivotTables, and PivotCharts: Pages EX 238-240; Exercises in Review Assignments (EX 272) and Case Problems 1-4 (EX 273-278)  
Tutorial 7, Using Advanced Functions, Conditional Formatting, and Filtering: Pages EX 373-378; Exercises in Review Assignments (EX 384) and Case Problems 1-4 (EX 385-391) |
### Goal 8: Scenarios
The student will develop scenarios for predictive analysis.

<table>
<thead>
<tr>
<th>Objective(S):</th>
<th>Indicator(S):</th>
<th>Suggested Activities: Book Chapter and Learning Exercises and Assessments Cengage New Perspectives Books</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1 Make predictions by creating scenarios.</td>
<td>8.11 Use what-if analysis to synthesis concepts and make predictions through scenarios and goal seeking.</td>
<td>Tutorial 10, Performing What-If Analyses: Pages EX 521-525 and EX 538-549; Exercises in Review Assignments (EX 566-567) and Case Problems 1-4 (EX 567-572)</td>
</tr>
</tbody>
</table>

### Goal 9: Working with Ranges
The student will group information.

<table>
<thead>
<tr>
<th>Objective(S):</th>
<th>Indicator(S):</th>
<th>Suggested Activities: Book Chapter and Learning Exercises and Assessments Cengage New Perspectives Books</th>
</tr>
</thead>
</table>
9.1 Name, use and edit ranges
9.11 Use the formula tab to name and set ranges, paste names and use names in formulas.

**TUTORIAL 7, USING ADVANCED FUNCTIONS, CONDITIONAL FORMATTING, AND FILTERING:**
*Pages EX 360-367; Exercises in Review Assignments (EX 384)*

**SAM ASSESSMENT AND TRAINING TASKS:**
722 Range Name – Create, 1274 Use a named range in a formula

---

**GOAL 10: INTERMEDIATE FORMULATIONS**
The student will utilize intermediate formulations to evaluate and analyze data.

**OBJECTIVE(S):**

| 10.1 Appraise/assess data through use of intermediate formulas that lookup and reference data, modify text, calculate dates/time, or use simple logic (IF, THEN, AND, OR, SUMIF, AVERAGEIFS..) |
| 10.1 Insert a date or time formula. |

**SUGGESTED ACTIVITIES:**

**BOOK CHAPTER AND LEARNING EXERCISES AND ASSESSMENTS CENGAGE NEW PERSPECTIVES BOOKS**

**10.12 Use transpose to modify an array.**

**TUTORIAL 10, PERFORMING WHAT-IF ANALYSES:**
*Page EX 537) (Only available in Comprehensive Edition)*

**SAM PROJECTS:**
New Perspectives Excel Tutorial 3 Case Problem 1; New Perspectives Excel Tutorial 3 Case Problem 1 (Scenario 2)

**10.13 Examine information by looking up and referencing an array of cells with HLOOKUP AND VLOOKUP.**

**TUTORIAL 7, USING ADVANCED FUNCTIONS, CONDITIONAL FORMATTING, AND FILTERING:**
*Pages EX 353-360; Exercises in Review Assignments (EX 384)*

**SAM ASSESSMENT AND TRAINING TASKS:**
1316 VLOOKUP, 1317 HLOOKUP

---

*There are several versions within the New Perspectives Series. This alignment presented works the New Perspectives First and Second Course Editions as well as the New Perspectives MS Excel Introductory Edition, and the New Perspectives MS Excel Comprehensive Edition. Please note that Chapter 9-10 are not available in the New Perspectives Second Course or Introductory Editions nor is Appendix C or D.*

*This alignment was conducted by members of the editorial staff of the Perspectives Series, representatives from the Cengage Learning Solutions group, SimNet representatives, and Cengage Enterprise Solutions sales representatives in partnership with Dr. Buzzetto-More.*

*McGraw Hill was contacted and provided the opportunity to prepare an alignment; however, no response was received.*
For more information, please contact:

MSDE Career and Technology Education Branch

200 West Baltimore Street
Baltimore, MD 21201-2595
Phone: 410-767-0170

http://www.marylandpublicschools.org/MSDE/divisions/careertech/career_technology

Prepared with special consideration by Dr. Nicole A. Buzzetto-More Associate Professor of Management, University of Maryland Eastern Shore and Director MSDE BMF Program Affiliate. Copyright 2011©. All rights reserved. This curriculum is designed for educational purposes. Users are forbidden to reproduce, republish, redistribute, or resell any materials from this document in either machine-readable form or any other form without permission of the MSDE.